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1. GENERAL

TQC Sheen Ideal Finish Analysis (IFA) is designed to download logger data to a computer, analyze 
the data and print reports. 

Ideal Finish Analysis allows the user to analyze data from various loggers. A separate module has 
been developed for each TQC Sheen logger: 

•	 Cure for the TQC Sheen CurveX
•	 Climate for the TQC Sheen DewCheck
•	 Thickness for the Defelsko PosiTector 6000
•	 Gloss for the TQC Sheen Glossmeter

The application can be configured for two different user levels: basic or advanced. In basic mode 
the user can download data to the computer and print standard reports. The advanced mode in 
TQC Sheen Ideal Finish Analysis provides users with a tool for customizing the reports generated 
by the software. Details such as the position of the probes and the shape or size of the measured 
object, calculation styles, etc. can all be integrated into the report. This allows users to refine the 
style of reports to meet their own requirements. Users of the advanced mode are considered 
to have a basic knowledge of Windows®-operated programs. Switch to the advance mode by 
choosing System Configuration from the Tools menu.

As the Ideal Finish Analysis software follows the Windows® style, this manual focuses on the 
actual functions and their options and the role they play in the entire software concept. 
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2.	QUICKSTART

2.1 Downloading the software

Requirements: 
•	 Internet connection 

Install the software on the PC you will be using to read measurement data. 
To download the software:
Step 1 	 Go to www.industrialphysics.com
Step 2	 Go to a CurveX product page 
Step 3 	 Click Access Ideal Finish software here: 
	 https://industrialphysics.com/software-uploads/ 
	 TQC-Ideal-Finish-Analysis-Setup-8.0.138.0.exe.zip
Step 4 	 Select the download folder
Step 5 	 Click on the exe file to install the software

2.2. Installation

This chapter explains how to install TQC Sheen Ideal Finish Analysis on a computer* 

2.2.1 Install on Windows pc 

Download TQC.Ideal.Finish.Analysis.Setup.6.0.112.exe (or higher) from the TQC Sheen website at: 
https://www.tqc.eu/en/service/software-downloads/

Once the installer is 
started dialog1 will be 
displayed with the 
Welcome to the 
Ideal Finish Analysis 
dialog.

* Ideal Finish is Windows 
based software and will 
not natively run on a Mac. 
In order to use Ideal Finish 
on a Mac you will need to 
install a virtual Windows 
operating system on the 
Mac. See 2.2.2.
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In dialog 1a click Install 
to continue the installation.

Dialog 1a

Dialog 1b
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To continue the installation 
please read the license agreement 
carefully and once done in dialog 
2 click the radio button I accept 
the terms in the License 
Agreement and click Next.

Dialog 1c

Dialog 2a
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Dialog 2b

Dialog 3 allows you to specify the 
installation location of your files. 
By default it will install in the My 
Documents folder. A network 
location can be entered if more 
people on a workgroup will use 
TQC Sheen Ideal Finish Analysis. 
Click Browse to change the 
location, click Customize to 
change the programs that will be 
installed, click Next to continue.

Dialog 3
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Clicking Browse will show 
Dialog 4 allowing you to change 
the destination folder of your  
user files.

Dialog 4

Customize will show Dialog 5 
allowing you to change the 
programs that will be installed. 
Click Disk Usage to check the 
required and available disk space, 
click Next to continue.

Dialog 5
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Dialog 6

In Dialog 6 the disk usage can 
be verified, click OK to return to 
Dialog 5 and continue the 
installation.

Use Dialog 7 to enter your 
personal information and 
preferences. The software will 
start-up in Advanced mode by 
default, for less experienced users 
a basic version is available. It is 
always possible to alter these 
parameters later on in the 
Options menu of TQC Sheen Ideal 
Finish Analysis.

Dialog 7
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Click Next in Dialog 8 to start
the installation.

Dialog 8

Dialog 9 shows the installation 
process of TQC Sheen Ideal Finish 
Analysis.

Dialog 9
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Dialog 10

Dialog 10 shows the finished 
installer, click Finish to remove 
the temporary installation files.

If problems occur and the drivers 
for the CurveX or Dewcheck are 
not installed properly they are 
available from the installation 
location that was set in Dialog 3. 
By default you will be able to find 
them in C:\Program Files\TQC\
TQC Ideal Finish V5\
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2.2.2  How to install Ideal Finish on a Mac

Ideal Finish is Windows based software and will not natively run on a Mac. In order to use Ideal 
Finish on a Mac you will need to install a virtual Windows operating system on the Mac. There are 
multiple options available to do this. TQC Sheen tested the operation of Ideal Finish with Parallels 
(desktop 11). This software can be downloaded from www.parallels.com.

What gauges can be connected to the Mac:
-	 TQC Sheen CurveX 3
-	 TQC Sheen Gloss meter
-	 TQC Sheen Equipment launched 2016 or later

What should you have available:
-	 A Mac suitable for running Parallels (please check www.parallels.com)
-	 License for Parallels
-	 License for Windows 8 or higher
-	 Approximately 50Gb free memory on the Mac

How to install Ideal Finish
Install Parallels as per manual of Parallels.

Install Windows within Parallels

In the main screen of Parallels select the setting wheel (second icon bottom row) 
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In the Settings menu 
select Hardware-> 
USB & Bluetooth -> 
USB Connection 
Preferences 

In this screen 
select [Ask me what 
to do] and close this 
screen. 
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Select Shared 
Printers and allow 
Mac printers to be 
shared with 
Windows.

Select Network 
and source shared 
network to allow 
windows to connect 
to the same WiFi 
network as the Mac

Now open Windows 
on the Mac and 
Install Ideal Finish as 
if it was a Windows 
machine (See 2.2.1). 
Follow Ideal Finish 
instructions.

In the Settings menu 
select Hardware-> 
USB & Bluetooth -> 
USB Connection 
Preferences 
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3  TQC SHEEN IDEAL FINISH ANALYSIS - THE SOFTWARE

This user-friendly software is designed to evaluate and analyze the data collected by your 
instrument data logger. The Ideal Finish software can be used in two modes: basic and advanced. 
In basic mode, the software allows you to define a paint type and view temperature profiles. 

TQC Sheen Ideal Finish Analysis is easy to use because its graphical user interface is based on 
standard Windows terminology and standard Microsoft terms. As a result, features such as prin-
ting and print previews are the same as in other standard Windows products (such as Microsoft 
Word). Please note that some of the dialog boxes will appear in the language of the version of 
Windows that is currently installed.

Screen 2.

1 2 3 4

1.	 Short cut menu	 
2.	 File explorer
3.	 Graph
4.	 Data view
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Screen 3.

If the correct COM Port has been selected, the serial number and the battery status of the data 
logger are displayed. If an error message is displayed, switch to another COM Port. If all COM 
Ports display an error message, make sure that the batteries are charged and the data logger is 
set to ON. Also check whether the data logger is connected to the PC and check whether the 
COM Port on the PC is free for use.

3.1  Configuring and testing communication
In order for the data logger to communicate with a Pc, use the cable to connect it to an available 
communication port on the Pc. once connected, communication can be tested by taking the 
following steps.

Step 1.	 Choose Configure & Test… from the Logger menu.
Step 2.	 Choose the communication port to which you have connected your data logger.
Step 3.	 Click Test. the serial number and battery status should appear. if not, check the
	 communication port, battery, cable and/or Pc settings.
Step 4.	 Press Start to check the probes. the probes should now give ambient temperature
	 readings.
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D
E

Screen 4.

3.2  System configuration
choose options… from the tools menu to define your preferences.

3.2.1  System configuration
Step 1.	 Change the user level to Advanced so that you can use all the features in 
	 TQC sheen Ideal Finish Analysis.
Step 2.	 Select your Language.
Step 3.	 Select the Temperature units.
Step 4.	 Select the Distance units.
Step 5.	 Select the Thickness units
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3.2.2  Company Detail
Step 8.	 Fill in the name, website, address and logo of your company. This information will be 		
	 used as header information on the reports created by TQC Sheen Ideal Finish Analysis.
Step 9.	 Click the Download Express tab.

Screen 5.
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3.2.3  Download Express
TQC Sheen Ideal Finish Analysis can speed up the printing of a report at the click of a single 
button. Switch TQC Sheen Ideal Finish Analysis to advanced mode to enable your line operators 
to print a report based on a template for specific processes.

Step10.	 Select Overwrite and replace files if they already exist to replace files already 
	 downloaded from the logger.
Step 11.	 Files will be automatically downloaded to the folder where profiles are located. 
	 Change the relative directory to download files to a different location.
Step 12.	 Enter the operator name to be placed on the report.
Step 13.	 Select the template to use for downloads.
Step 14.	 Click OK to save the changes.

Screen 6.
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4  TQC SHEEN IDEAL FINISH ANALYSIS – BASIC MODE

To make full use of the analysis software, follow all the steps in this chapter. Refer to screen 2 for 
the main control areas. The Shortcuts menu contains tips on easy access to the various options in 
TQC Sheen Ideal Finish Analysis.

4.1  Setting up your instrument
Every time before you start temperature logging, you must first define the sample rate and paint 
types. After you define the interval time, the temperature scale (Centigrade / Fahrenheit), the 
date and time are also specified.

N.B.	 The system uses the data logger’s ID and batch number to generate a unique profile 	
	 name. If a profile with that name already exists on disk, it is assumed that the user does 
	 NOT want to download (and overwrite) this profile. In addition, the system adds the 
	 recently downloaded files to its downloaded file list in the File Explorer.

N.B.	 The system automatically adds ‘time above’ values to the Result screen for the paint 
	 type defined at reset.
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4.1.1  Specifying the interval time (step 1 of 7)
Step 1.     Choose User settings… from the logger menu.
Step 2.     Change the interval time, the time between measurements.
	 When you increase this value, you increase the data logging time for one block of 
	 memory 
Step 3.     Click Next.

Screen 7.
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4.1.2  Specifying the units and synchronize PC time (step 2 of 7)
Step 4. 	 Select the display untis
Step 5.	 Check the synchronize check box. This will set the data logger time to the Pc time.
Step 6.    	Click Next.

Screen 8.
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4.1.3  Specifying the batch names (step 3 of 7)
Step 7. 	 Specify the name for each group of measurements
Step 8.	 Click Next.

The dialog, depending on the instrument, will display the amount of batches (groups of 
measurements) and  allow you to specify a name for each group.

Screen 9.
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4.1.4  Specifying the START/STOP time and temperature (step 4 of 7)
in this step in the user settings Wizard, you can define a start and stop temperature or time. 
only the values are defined here; you must make the actual start on the logger.

Step 9.	 If desired, click Enabled and define the start and stop temperatures.
Step 10.	 If desired, click Enabled and define the start and stop time.
Step 11.	 Click Next.

Screen 10.
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4.1.5  Specifying the cure specifications (step 5 of 7)                                                                                
In this step in the User Settings Wizard, you can add paint types to the instruments. The type 
of instrument defines the maximum number of paint types that can be stored on the 
instrument. The paint types are listed in the Paint types window, where a summary of the 
selected paint type is displayed on the right.

Step 12.	 Click the Open File button (          ) to view the available paint types and add the 
	 required type. Do this for each individual paint type.
Step 13.	 Use the move uP/DoWn or Delete buttons to complete the list.
Step 14.	 Click Next.

Screen 11.
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1

3

Legend

1.	 Has been sent from this PC for this serialnumber to the logger, but needs 
	 to be resynched as the logger one has changed.
2.	 Has never been sent  from this PC for this serialnumber, so just leave it 
	 alone.
3.	 This paint type is corrupted.

2

Screen 12.
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Screen 13.

4.1.6  Selecting the cure specificationactive paint type (step 6 of 7)
Once the paint types have been added to the paint library, you need to select the paint type to 
be used to calculate the cure index on the instrument. The default paint type is the type 
currently active on the instrument.

Step 15.	 If a paint type other than the current type is to be used, click the arrow to the right 
	 of the list box to display the added paint types. select the paint type required for the 
	 next cure index calculation, and then click Finish.
Step 16.	 If the current cure specification is to be used, click Next.
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4.1.7 Selecting the active paint type (step 7 of 7)
Some extra information about the operator and location can be added to this instrument when 
used in real time recording mode. 

Step 17.  Enter the part information.
Step 18.  Enter the location information.

Screen 14.
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4.2  Downloading data

4.2.1  Selecting download batches
After data has been recorded, it is downloaded to the PC with the 
Download Logger Wizard. To do this, take the following steps:

Step 1.	 Choose Download all data to PC… from the Logger menu.
Step 2.	 Specify the location to which the batches must be downloaded.
Step 3.	 Download all batches (default) or remove batches from the download list by checking 		
	 the checkbox.
Step 4.	 Click Download.

Screen 15.
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4.2.2  Specifying environment details
Step 5.	 Choose the Operator, part and location.
Step 6.	 Click the Probe Names tab.

Screen 16.
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4.2.3  Specifying probe names
Step 7.	 Choose the probe names - for example, air-probe, top-probe 
Step 8.	 Click Download for each batch to be downloaded. Click Skip to cancel the batch 
	 download.

Screen 17.
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4.3  Setting up a paint type
You can define and add default paint types for general or future use. Once a paint type has been 
defined, it can be linked to a batch with data at any time to create a profile. Two default sample 
paint types have already been installed:
•	 Paint1: a yellow paint that cures between 160°C and 200°C.
•	 Paint2: a clear coat paint that cures between 120°C and 160°C.
These paints are used in oven1 and oven2 and have corresponding profiles: profile1 and profile2.

4.3.1  Adding a new paint type
Step 1.	 Click the Paint-Types icon in the Shortcuts menu.
Step 2.	 Click the New button to start a new paint type.
Step 3.	 Enter the name of the paint type to be used.
Step 4.	 Click OK and then Save in the “Save as” dialog box. The “Save as” dialog box, which is 		
	 not displayed here, is a standard windows dialog box that appears after you click OK.

Screen 18.
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4.3.2  Defining general paint information
After you have added the new paint type, you can define general cure information for this paint 
type. This information will be used by TQC Sheen Ideal Finish Analysis to analyze all the measu-
red data and calculate new views for a better cure. The paint manufacturer usually supplies this 
information together with the paint.

Step 5.	 Select the Units measure in degrees Celsius or Fahrenheit.
Step 6.	 Define the Maximum and Minimum cure boundaries for the paint type. This is usually 		
	 the highest and lowest value of the paint cure specification. The cure is calculated from 	
	 the Min to the Max value. The curve outside these boundaries remains unused.
Step 7.	 Define the Number of points for the cure rate curve, this defines the number of point 
	 available on the Cure Parameters Tab.
Step 8.	 Select a cure characteristic Style:
	 •	 Standard (Exponential)
		  Most commonly used and most accurate cure calculation method according 		
		  to a curved line.
	 •	 Linear
		  Cure calculation according to a straight line.
Step 9.  	 Define the Number of points  for the Time above constraints, this defines the number 
	 of points available on the Constraints Tab. Check the box for Minimum and Maximum 
	 constraint to add these two cure parameter as curing constraint.

Screen 19.
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4.3.3  Defining cure parameters
Step 9.	 Click the Cure Parameters tab.
Step 10.	 You can select the time-temperature pairs (points) by changing the Id or clicking 
	 directly on the points with a mouse. The number of points was defined in Step 7 on the 
	 General tab.
Step 11.	 Once the Id is selected, the values are changed according to the paint specifications 
	 supplied by the manufacturer. After you finish defining the paint type, the program will 
	 ask you if you want to save the changes; click OK.
	 In general, the highest and lowest values are defined on the Maximum (red) and 		
	 Minimum (blue) lines. TQC Sheen Ideal Finish Analysis will always send three 
	 points to the instrument:
	 1.	 The Maximum value, which is the intersection of the curve with the Maximum 
		  (red) line.
	 2.	 The Minimum value, which is the intersection of the curve with the Minimum 
		  (blue) line.
	 3.	 A point in between. The user can indicate multiple points. The point nearest to the 
		  middle is used.

Screen 20.
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4.4  Viewing temperature profiles
The data batches can be viewed in various formats and analyzed once they have been selected 
as profiles in the File Explorer area. Follow the steps below to view a batch in the default 
2D-Graph.

Two sample profiles
The sample profiles with the corresponding ovens and paint types are designed to demonstrate 
the use of the CurveX data logger in the process of painting a Giant bike yellow. See the Image 
tab in the Probe Layout.

Two default sample profiles have been installed:
•	 Profile1: a run through oven1 with paint1 (yellow)
•	 Profile2: a run through oven2 with paint2 (clear coat)

Step 1.	 Click the Profile icon in the Shortcuts menu.
Step 2.	 Select a batch in the File Explorer.

Screen 21.
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4.4.1  Zooming in and out on 2D graphs
Step 1.	 Click and hold down the left mouse button in the 2D graph.
Step 2.	 Drag the mouse pointer to the opposite corner and release the mouse button.

Screen 22.

Zoom area



38 |

4.4.2  Analyzing profile data
Step 1.	 Click the Results tab to view the batch data in columns.
Step 2.	 Click  the Notes tab to view, edit or add to your notes.
Step 3.	 Click the Details tab to view or change the Operator name, Part or Location.
Step 4.	 Click the Probe Position tab to view or change the probe names and colors.

Screen 23.

LEGEND

Name	 The probe label name 
Cure Index	 A cure index of 100 means perfect process conditions. Values below 100 or 		
	 much higher than 100 require attention.
Max.temp.	 The maximum temperature reached on this probe during this measurement. 
Time Above…	 The time that the temperature exceeded the temperature specified in the Time 	
	 Above column header.
Peak Diff	 The time during which the biggest difference in temperature occurred.
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4.4.3  Adjusting collection details
It is possible to view the collection details and define another paint type, if required.

Step 1.	 Choose Collection Details… from the Profile menu and select the Links tab; click OK.
Step 2.	 Choose the desired objects you want to link to this particular profile. 			 
	 When you select a new paint type, the cure results will be recalculated.
 

Screen 24.
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4.4.4  Printing a paint type or profile data
Once a profile or paint type has been selected in the File Explorer, you can send it to a Printer or 
an email program.

Step 1.	 Choose Print from the File menu to send the data to a printer.
Step 2.	 Choose Send from the File menu to send the report to an email program.
 

Screen 25.
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4.4.5  Preview profile data
Use the Print Preview option from the File menu or toolbar to view the report.

 
Screen 26.

4.4.6  Print format setup
Use the format setup options to tailor printed report properties to your needs.

From the File menu select Print…  followed by Setup…
 
Screen 27.
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From the Print Preview dialog select the Print format setup 

 

Screen 28.

Use the format setup options to tailor printed report properties to your needs.

Screen 29
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4.5 Basic report
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5  TQC SHEEN IDEAL FINISH ANALYSIS – ADVANCED MODE

The advanced mode in TQC Sheen Ideal Finish Analysis provides users with a tool for 
customizing the reports generated by the software. Details such as the type and size of the oven, 
the position of the probes and the shape of the product, paint specifications, calculation styles, 
etc. can all be integrated into the report. This allows users to refine the style of reports to meet 
their own requirements.

Switch to the advance mode by choosing System Configuration from the Tools menu. The 
Advanced mode of this software is separate from the Basic mode. Users of the advanced mode 
are considered to have a basic knowledge of Windows®-operated programs. As the TQC Sheen 
Ideal Finish Analysis software follows the Windows® style, this manual does not explain each 
step to be taken to change specific settings. Instead, it focuses on the actual functions and their 
options and the role they play in the entire software concept.

Users can use TQC Sheen Ideal Finish Analysis to view and interpret profile data in the following 
way:
•	 Data tabs:
	 as calculation or data results in columns.
•	 Graph bar:
 	 as data results in several graphs.
The various settings for data and graphical calculations are explained in Sections 5.1 and 5.2.

5.1  Data tabs
On the data tabs, various calculations and settings can be applied to the downloaded data. 
esides the data tabs in basic mode, data can be viewed in columns, oven settings can be 
applied, probe properties can be modified, and reference curves can be used to compare 
previous measurements with current measurements.

5.1.1  Results
In Advanced mode, result columns can be added, modified or deleted from the Results tab sheet 
as desired. To do this, click the column header with the right-hand mouse button to display a 
shortcut menu that you can use to change the column properties. The possible calculations are 
explained in the next chapters. Please note that these calculations are applied to the profiles and 
not to the paint type. The paint type may be used as input parameters (e.g. cure value).

Most of these calculations can be considered to be over a region of the profile - for example, the 
whole profile or the current zoom or a specific zone. The software can therefore be configured to 
display the result over the specified area - for example, Max. temperature over the whole profile 
or just the current zoom, and so on....
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5.1.1.1  Max. temperature 
Calculates the maximum temperature, which is useful to ensure that the product is at the right 
temperature. This is the maximum temperature that a specific profile has reached, so if the 
maximum temperature for probe1 equals 205 that means that the profile reached 205.

5.1.1.2  Time of Max. temperature
Calculates the time that the temperature has been at a certain maximum.

5.1.1.3  Min. temperature
The minimum temperature is really only useful if oven zones have been defined. Then it is 
possible to make sure that the product has reached the correct temperature while entering or 
leaving a zone.
 
5.1.1.4	 Time of min. temperature
Calculates the time that the temperature has been at a certain minimum.

5.1.1.5	 Average temperature
Calculates an average probe temperature within a zone. The option can be used to make sure 
the product has been exposed to a reasonable temperature within the zone.

5.1.1.6	 Largest rate of rising temperature 
Calculates the moment at which the temperature rises the fastest. This is useful to ensure that 
the product has not been heated too quickly. (an "orange peel" effect can sometimes occur).

5.1.1.7	 Time of largest rate of rising temperature
Calculates the range of time during which the temperature increase is the fastest.

5.1.1.8	 Largest rate of falling temperature 
Calculates the moment at which the temperature falls the fastest. This is useful to ensure that the 
product does not cool too quickly.

5.1.1.9	 Time of largest rate of falling temperature 
Calculates the range of time during which the temperature drop is the fastest.

5.1.1.10	 Peak difference 
Calculates the balance of heating over all probes. This is useful to ensure that the product was 
evenly cooked all over (curing conditions should have the right temperature for the correct 
melting and cross-linking of the powder).

5.1.1.11	 Time above 
Calculates the time this particular probe measured a temperature higher than the temperature 
specified. (Note the extra time field is used to allow the text to turn red if it has not received the 
correct level of time.)
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5.1.1.12	 Rising time between temperatures 
Calculates the rate of temperature rise within a certain period. This is useful to ensure that the 
product is not heated up in too short a time (as this could prevent the mechanical transformation 
of the product).

5.1.1.13	 Falling time between temperatures 
Calculates the rate of temperature fall within a certain period. This is useful to ensure that the 
product is not cooled down in too short a time (as this could prevent the mechanical 
transformation of the product).

5.1.1.14	 Time between temperatures 
Calculates the time span defined between the lower and upper temperature. 

5.1.1.15	 Cure 
Calculates the cure level, a number based on the summation of the cure below the cure 
parameter values. This is a useful number when comparing cures or when decreasing the 
time-temperature values to an optimum at which the cure remains sufficient.

5.1.1.16	 Time rising temperature reached 
Calculates the first time that the specified temperature occurred on the rising temperature 
slope. The sampling starts from the beginning of the profile and checks the first time the profile 
exceeds the specified temp.

5.1.1.17	 Time falling temperature reached  
Calculates the last time the  specified temperature occurred on the rising temperature slope. 
The sampling starts from the end of the profile and looks backwards to find out the first time the 
profile exceeded the specified temp.

5.1.1.18	 Time above excluding 
Calculates the Time above but excludes temperature values. This is useful when comparing 
calculations on profiles with the EasySoft / AOLS program. 

5.1.2  Notes 
Use this option to add additional information for the current profile.

5.1.3  Details
Use this option to add customer or owner information.

5.1.4  Data
On this tab, the data can be analyzed in columns. Each logging is shown in a row of data for each 
probe. Use the UP/DOWN arrows and the PAGE UP/DOWN, HOME and END keys to scroll through 
the data. A vertical marking line in the graph follows the scrolling movement.
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5.1.5  Oven start
Use this option to define the moment the logger entered the oven, manually or automatically. It 
activates an automatic search for the first moment of temperature rise in the profile.

5.1.6  Events
When tolerance bands are used, events are generated automatically if the profile values are 
outside the tolerance band region. For each event, the Start time, the Stop time, the event Id and 
the event Description is logged.

5.1.7  Probe position
For each probe, some of the properties can be modified here. All changes apply immediately in 
the probe layout files.

5.1.8  2D Overlay
Select the overlay file or graphical cure with which to compare the current profile data.

5.2  Graph bar
In order to visualize the measured data, the TQC Sheen Ideal Finish Analysis program has been 
downloaded from the logger. 

5.2.1  Graph options
For the 2D, 3D and Time above graphs, the Graph Options icon is active. Line styles, colors, 
thickness, limits and fill colors can be customized in this section. In basic mode, only the 2D 
graph is available.

5.2.2  Two dimensional graph
Click on the 2D icon to view the data in a two-dimensional graph. Define the graph options as 
desired and define measurement points by clicking the left-hand mouse button in the graph at 
the positions where you would like more detailed information. Remove measurement points by 
clicking the right-hand mouse button on the spot. To compare the graphical cure with the 
current profile, define the option ‘Overlay Graphical Cure’ in the 2D overlay tab of the data tabs.

5.2.3  Time Above constraints
Click on the Time Above icon to view the constraint data in a two-dimensional graph.

5.2.4  Graphical Cure
Graphical Cure displays the cure number in time. This graph is very useful for determining the 
time at which a cure of 100 was achieved on all probes. A cure of 100 is the optimum time-
temperature value for this particular product.

5.2.5  Three dimensional surface graph
The most extensive view of profile data is displayed in a three dimensional surface graph. In this 
graph, all probe data is linked to simulate the cooking of the object surface at any point in time. 
If an oven has been linked, the oven zones can also be displayed in customized colors. Define the 
graph options for various displays and an easy analysis of the entire cooking process.
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Example:
Assuming that line speed, etc. has been entered, the probes are offset along the probe line 
according to the probe leading edge. The probes will also exhibit lag according to their position 
in the direction of flow. This should mean that the 3D graph is a reasonable representation of 
how the temperature is flowing from the perspective of the oven. This is the reason why the 3D 
graph can be viewed in zones.

5.2.6  2D graph zoom
There are many methods that can be used to define the zoom for a graph:

Zoom by keyboard:
•	 Alt+1 means zoom to zone 1, Alt+2 means zoom to zone 2, etc. up to Alt+0, zoom to zone 10.
•	 You can use the Tab key to switch between the different zones.

Zoom by mouse:
•	 Click and hold down the right-hand mouse button to display the pop-up zoom menu.
•	 Zoom in by selecting an area on the 2D Graph.
•	 Switch back to full zoom by clicking once with the right-hand mouse button.
	 Zoom in the Graphical Overview window:
•	 Choose Graphical Overview from the View menu. This feature is also available in the Print-		
	 Preview menu.

The overview window displays the full graph, with a shaded edge box displaying the current 
zoom. This box is called the “zoom tracker”. The zoom tracker has handles at the edges and 
corners. Move and re-size the zoom tracker using the mouse. Move the mouse over the zoom 
tracker and see how it changes when positioned over the handles. Drag these handles to change 
the zoom, or drag the entire zoom tracker from the Graphical Overview toolbar.

5.2.7  3D graph zoom
Zoom by keyboard:
•	 Press the + and - keys to zoom in and out
•	 Press the LEFT/RIGHT arrow keys to rotate clockwise and counterclockwise (hold down the 		
	 SHIFT key for more refined control)
•	 Press the UP/DOWN arrow keys to view the graph from above or below, and press CTRL and 		
	 UP/DOWN arrow keys to move the graph up and down.
•	 Press the HOME/END keys to view the graph in the default position from the front or back

6  ADVANCED SETUP

In the Advanced mode, there are several extra options in the Shortcuts menu.

6.1  Ovens
You can use this option to specify one or more ovens. The measured data will be displayed with 
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the specified oven in the background. Especially for larger ovens, this clearly visualizes the 
position in the oven of possible spikes or other irregularities in the temperature graph. An 
unlimited number of ovens can be created; this is quite convenient for users who visit many 
different facilities.

The following details can be defined for each oven:

6.1.1  General
On this tab, the physical structure of the oven is specified. The Control option is used to define 
the maximum number of controls for each zone. A control could involve a thermostat, an air 
valve, or a ventilator switch, etc. By documenting the settings, the specific setup of the oven is 
recorded.

6.1.2  Zone details
Specific details can be defined for each zone.

6.1.3  Control details
Each control can be specified here.

6.1.4  Controls available
For each zone, you can specify which controls are available. For example, an air curtain is often 
found at the “entry zone” (on/off switch in zone 1) but not in further zones. 

6.1.5  Description
Here you can enter a description of the oven for further identification.

6.2  Oven set up
An oven can be defined in different ways in order to suit various production processes.

6.2.1  General
Here you can define the units and other general settings for this option.

6.2.2  Line speed
Here you can define the speed of the conveyor. (Line speed affects calculations of the probe lag 
option as described in the chapter on Probe Layout.)

6.2.3  Control settings
Here you can record the setting of each control for each zone.

6.2.4  Description
Here there is space to include specific information about the setup, which makes it easier to 
identify the setup later.

6.3  Probe Layout
The Probe Layout option enables you to define default probe positions on the cure object. This is 
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very useful when focusing on the probe settings for each individual product, many of which are 
processed frequently but are not necessarily the only products. Once a probe layout has been 
created and / or selected, the following properties can be defined.

6.3.1  General
Define the number of probes for the current probe layout. The “Auto generate probe lags” setting 
enables the program to synchronize the oven time/distance lag with the product. This is very 
useful when viewing the profile of a large product because the first probe will enter the oven a 
lot earlier than the last probe. When you define the “Auto generate probe lags” option, you can 
also define the direction of flow of the product, which is then important.

6.3.2  Image
Use the product image to get a good impression of the probe positions. The image size and 
orientation are defined to reflect reality as much as possible. These measures will be used when 
calculating the probe lags.

6.3.3  Details
In this section, you can define extra details (probe properties for each individual probe). The 
probe position is easy to move with a mouse; just click the probe in the image area and drag it 
into position. Note that when “Auto generate probe lag” is selected on the General tab, the Lag 
text box is disabled for data entry. Disable the “Auto generate probe lag” option and define a 
custom probe lag here. When you select the air probe check box, you exclude the probe data to 
be used when calculating the peak difference.

6.3.4  Colors
Here you can change the probe colors. Colors will appear on a printed or mailed report in the 
way they are defined in this section.

6.3.5  Gridlines
Use this option to enable or disable the horizontal and vertical gridlines on this tab sheet. You 
can also customize the gridline color and/or style. 

6.4  Paint types
This option is used to manage the library with different paint types, together with their cure 
specifications and, if required, several extra constraints.

6.4.1  General
In this section, the general settings of the paint are defined, such as the number of cure 
characteristics (time-temp pairs), number of constraints, and other settings.

6.4.2  Cure Parameters
Here you can program the paint cooking schedule provided by the paint manufacturer.

6.4.3  Constraints
This option has been developed for professional users who are interested in optimizing the 
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efficiency of their total production process. By defining several constraints, users can create a 
“region of acceptability” or “cure window”.

The smaller this cure window, the more efficient the production process will be. It is assumed 
that users will probably refine the cure window over time using their experiences with earlier 
tests.

Typical constraints include the minimum and maximum temperature and times of a powder 
coating but other constraints may also be taken into consideration.

Example 1.
A paint type has a maximum application temperature of 250°C. However, the parts that are being 
coated may not exceed 200°C because of mechanical properties (e.g. stress). 
This user will add a maximum temperature constraint at 200°C although the paint specification 
specifies a different temperature.

Example 2.
On an assembly line (for example, a car manufacturer), the coating process and curing oven is 
just one of the many processes. If all processes do not need more than 14 minutes, for example, 
it is desirable to create a cure process that does not take longer than 14 minutes. In this case a 
constraint would be set at 14 minutes.

Example 3.
The maximum line speed of the conveyer belt is 15 feet / minute. Knowing the oven temperature, 
oven length and object mass, the line speed could be a constraint to take into account. 

6.4.3.1  Hatching
Those parts that are outside the cure window should be hatched. In sample 1 above, the part 
“greater than” the line at 200°C should be hatched.

6.4.3.2  How to judge the “Time Above” graph
All the lines in the graph should cross the cure window. It is sufficient if they just cut the corner.

6.5  Tolerance Bands
Using tolerance bands, it is possible to define a region in which the profiling will fit. You do this 
prior to the measurement using various data such as paint curing information, material stress, 
oven heating capacity and other possible variables. A tolerance band predefines the curing 
process bandwidth. Tolerance bands can be set as overlay in the profile 2D overlay tab. If values 
are outside the tolerance band region, events are generated automatically on the Events tab.

6.5.1  General
In this section, you define the general settings of the tolerance bands.
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6.5.2  Phases
Build the tolerance band in this section by defining the number of phases and the duration, 
starting point and end point of each phase.

Screen 30.

6.6  Ideal Cure
Ideal cures are all ideal process variables together. Once the profiling has been performed under 
ideal circumstances, it can be saved as an ideal cure and defined as overlay on the profile 2D 
overlay tab for future analysis of the ongoing processes.

Ideal cures are generated over a single probe, multiple probes, the average or peak difference of 
a single probe, or all probes.
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Screen 31.

6.6.1  General
Define the general preferences for the ideal cure.

6.7  File - Save As Special
The File menu contains five advanced options under Save As Special.

6.7.1  Save As HTML
Use this option to save any of your profiles in HTML format.

6.7.2  Save Zoom As
Use this option to save a selected area of your profile to a new profile. You can save only the 
interesting area of a profile, or save a multiple profile run (using the 1 big log block) into 
individual profiles.

6.7.3  Save As Tolerance Band
Use this option to create a tolerance band based on a profile. The tolerance band can be based 
on a single probe, multiple probes, the average or peak difference of a single probe, or all probes. 
Tolerance bands can be defined as overlay in the 2D profile overlay tab.
•	 Specify the upper and lower limit to define the bandwidth of the tolerance band.
•	 Use Filter Rolling Average to reduce noise on the tolerance band.
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•	 NUMBER OF POINTS is the value for points in the tolerance band. The original profile is made 
up of many points, normally around 500 (depending on the sample rate and run length). The 
tolerance band will tend to be a smaller number of points, which will be drawn faster on the 
screen.

6.7.4  Save As Ideal Cure
Use this option to save your optimum process variables in a new curve. Ideal cures are 
generated over a single probe, multiple probes, the average or peak difference of a single probe, 
or all probes. Once saved as the ideal cure, the graph can be overlaid in the profile 2D overlay tab 
for future analysis of the ongoing processes.

6.7.5  Save As Reference File
Use this option to make a copy of a profile and save it in the reference file folder of TQC Sheen 
Ideal Finish Analysis. Reference files can be overlaid in the profile 2D overlay tab for future 
analysis of the ongoing processes.

6.8  Templates
Templates are the most convenient way of combining the settings of an oven, a probe layout and 
a paint type in one setup file. Even customized calculation columns or graphical overlays can be 
preset in a template. Once the template has been created, this particular setup can be used again 
at any time when the same product or situation occurs on the production line.

One special template is called Default.tem, which is located in the Templates directory in 
TQC Sheen Ideal Finish Analysis. The template may be modified as desired but may never be 
deleted, as it is the default template on which all settings in basic mode are based.

6.8.1  Links
Use this option to specify the link between the various settings. In the first section, select the 
oven with the corresponding oven setup. If several oven configurations have been created for 
this oven, select the desired configuration here. An automatic oven start will search for the first 
rise in temperature in the profile linked to this template. In the second and third sections, you 
can define the setting of the probe layout and the paint type.

6.8.2  Overlay
In this section, previous profiles and graphical cure can be defined as references for future 
measurements. For an overlay of the graphical cure, check the check box. The profiles to refer to 
during any future measurement can be added in the Files box. See the Run chapter earlier in this 
manual for the exact meaning of these functions.

6.8.3  Results
Use this option to add the Results columns, which should be displayed on the screen and in 
reports. These settings will be used as default column settings for future measurements. Each 
column can be customized according to your preferred settings. See the Run chapter earlier in 
this manual for the exact meaning of these functions.
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6.8.4  Notes
Use this option to add any extra template information.

6.9  Advanced report
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7  ADDITIONAL FEATURES

7.1  Options
A number of other options for customization are located under Options from the Tools menu. 

7.1.1   View
Use this option to define extra options, such as displaying short cuts. You can change the default 
settings for the optimum configuration.
Show shortcut keys: Display the shortcut keys in the tool tips, menus and/or toolbars.
Show toolbar images: Display menu images in color and/or display the TQC Sheen Ideal Finish 
Analysis logo.
Hot key look: A pop-up control menu is displayed when the mouse moves over the control.

7.1.2   General
Animated zooms: uncheck when the PC is low on resources (graph overview, changes of zooms 
will not be displayed in real time!).
Reload document: when enabled, the software loads the last viewed document at the next 
start-up.
Save images as JPEG’s: This option is used when sending emails or saving as HTML. The graph is 
stored in JPEG format (this is the default format).
Compression level: Only supported by Windows 2000 and Windows XP; higher compression 
reduces the size but also the quality.

7.1.3   File locations
Define the path to the various TQC Sheen Ideal Finish Analysis files. In a network situation, the 
system administrator would normally define the path for these files to the network file server. 
This would then enable the files to be dealt with centrally - for example, standard oven definiti-
ons. 

7.1.4  Colors
Define custom colors here as desired. A list of ten custom fields can be added to the system 
configuration.

7.1.5  Macro Security
Define the macro security level on this tab. In TQC Sheen Ideal Finish Analysis, you can run 
macros written in Visual Basic. Sample files are located in the Software Development Kit (SDK) 
folder C:\Program Files(x86)\TQC\TQC Ideal Finish Analysis V4\SDK. 
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7.2  Shortcuts
ALT+0	 Graph zoom to zone 10
ALT+1	 Graph zoom to zone 1
ALT+2	 Graph zoom to zone 2
ALT+3	 Graph zoom to zone 3
ALT+4	 Graph zoom to zone 4
ALT+5	 Graph zoom to zone 5
ALT+6	 Graph zoom to zone 6
ALT+7	 Graph zoom to zone 7
ALT+8	 Graph zoom to zone 8
ALT+9	 Graph zoom to zone 9
	
ALT+CTRL+D	 Graph Animate Start
	
CTRL+C	 Edit Copy
CTRL+D	 Edit Default
	
CTRL+N	 File New
CTRL+O	 File Open
CTRL+P	 File Print
CTRL+S	 File Save
ALT+F4	 File Exit
CTRL+SHIFT+O	 File Open Profile
	
F1	 Help Index
F5	 Additional options Refresh
	
TAB	 Graph overview Zoom to next zone
SHIFT+TAB	 Graph overview Zoom to previous zone
	
CTRL+E	 Collection details
CTRL+L	 Logger download
SHIFT+L	 Logger upload/reset
	
	
CTRL+ALT+0	 Oven
CTRL+ALT+S	 Oven Set-up
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HOME Full zoom

Arrow up 	 Move graph up
Arrow down 	 Move graph down
Arrow left 	 Move graph left
Arrow right 	 Move graph right
 
SHIFT+Arrow up 	 Move graph up fast
SHIFT+Arrow down 	 Move graph down fast
SHIFT+Arrow left 	 Move graph left fast
SHIFT+Arrow right 	 Move graph left fast
 
CTRL+Arrow up 	 Zoom graph out vertically  
CTRL+Arrow down 	 Zoom graph in vertically
CTRL+Arrow left 	 Zoom graph out horizontally   
CTRL+Arrow right 	 Zoom graph in horizontally
 
CTRL+SHIFT+Arrow up 	 Zoom out vertically fast
CTRL+SHIFT+Arrow down 	 Zoom in vertically fast
CTRL+SHIFT+Arrow left 	 Zoom out horizontally fast
CTRL+SHIFT+Arrow right 	 Zoom in horizontally fast
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8  DISCLAIMER
 
The right of technical modifications is reserved.

The information given in this manual is not intended to be exhaustive and any person using the product 
for any purpose other than that specifically recommended in this manual without first obtaining written 
confirmation from us as to the suitability of the product for the intended purpose does so at his own 
risk. Whilst we endeavour to ensure that all advice we give about the product (whether in this manual or 
otherwise) is correct we have no control over either the quality or condition of the product or the many 
factors affecting the use and application of the product. Therefore, unless we specifically agree in writing 
to do so, we do not accept any liability whatsoever or howsoever arising for the performance of the 
product or for any loss or damage (other than death or personal injury resulting from our negligence) 
arising out of the use of the product. The information contained in this manual is liable to modification 
from time to time in the light of experience and our policy of continuous product development.
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